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1 ABBREVIATIONS 

Abbreviation Explanation 
ANZ Australia and New Zealand, 921.42 MHz frequency 
CD Compact Disc 
COM Serial port interface on IBM PC-compatible computers 
EU European Union, 868.42 MHz frequency  
HEX Intel HEX is a file format for conveying binary information for applications like 

programming microcontrollers, EEPROMs, and other kinds of chips 
HK Hong Kong, 919.82 MHz frequency 
ID Identification number 
IN India, 865.22 MHz frequency 
JP Japan, 950.95 MHz frequency 
MY Malaysia, 868.2 MHz frequency 
NaN Not a number 
PC Personal computer 
RF Radio Frequency 
RSSI Received Signal Strength Indicator 
SW Software 
TF Test Frequency 
US United States, 908.42 MHz frequency 
USB Universal Serial Bus, a serial bus standard to interface devices 
XML Extensible Markup Language 
 

2 INTRODUCTION 

2.1 What is Z-Wave Zniffer 

The Z-Wave Zniffer application is a development tool for capturing Z-Wave RF communication and 
presenting the frames in a graphical user interface on a PC. The tool shows the node ID of the Source 
and Destination for the communication, the type of frame [2] being sent, and the application content, i.e. 
the specific command, which is being sent. 

The Zniffer tool listens passive to the Z-Wave network traffic, and will only display the RF 
communications taking place within direct RF range. Be also aware that Zniffer can occasionally miss RF 
communication even from Z-Wave nodes within direct range. 

2.2 Purpose 

The purpose of this document is to describe the Z-Wave Zniffer development tool used during SW 
application development for debugging etc. 

2.3 Audience and prerequisites 

The audience is external R&D software application programmers. 
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2.4 Files at Developer’s Kit CD 

The Z-Wave Zniffer includes the Windows application and an embedded application hosted by the 
Z-Wave Module operating as sniffer.  

The Developer’s Kit CD contains the “\data\DevKit\Tools\Zniffer\” folder with the following sub-folders and 
files: 

Filename Description 

\PC\setup.exe 

\PC\ZnifferSetup.msi 

Microsoft Windows Installer files for Z-Wave Zniffer 
(Windows application)  

\Z-Wave_Firmware\sniffer_zw020x_anz.hex 

\Z-Wave_Firmware\sniffer_zw020x_eu.hex 

\Z-Wave_Firmware\sniffer_zw020x_hk.hex 

\Z-Wave_Firmware\sniffer_zw020x_in.hex 

\Z-Wave_Firmware\sniffer_zw020x_my.hex 

\Z-Wave_Firmware\sniffer_zw020x_us.hex 

The hex file required for running the Zniffer on an 
EU/US/ANZ/HK/IN/MY ZW0201 based Z-Wave 
module. This module supports 9.6 kbps and 40 kbps 
RF communication. 

\Z-Wave_Firmware\sniffer_zw030x_anz.hex 

\Z-Wave_Firmware\sniffer_zw030x_eu.hex 

\Z-Wave_Firmware\sniffer_zw030x_hk.hex 

\Z-Wave_Firmware\sniffer_zw030x_in.hex 

\Z-Wave_Firmware\sniffer_zw030x_my.hex 

\Z-Wave_Firmware\sniffer_zw030x_us.hex 

The hex file required for running the Zniffer on an 
EU/US/ANZ/HK/IN/MY ZW0301 based Z-Wave 
module. This module supports 9.6 kbps and 40 kbps 
RF communication. 

\Z-Wave_Firmware\sniffer_zw040x.hex The hex file required for running the Zniffer on a 
ZW040x based Z-Wave module. This module supports 
9.6 kbps, 40 kbps and 100 kbps RF communication on 
all frequencies. 

 

If your computer is set up to play automatically the CD or DVD when it is inserted and you opened the 
browser with Z-Wave Developer's Kit start page, then select “Developer's Kit SW” in the horizontal 
navigation bar at the top of the page and then select “Explore the software directories here” link to open 
the appropriate parent folder at Developer's Kit CD. 

Developer's Kit CD contains also the Z-Wave Zniffer User Guide. If you opened the browser with Z-Wave 
Developer's Kit start page, then click the “Software documentation” in the horizontal navigation menu on 
the top of the page. At the Software documentation page that is opened, select “Z-Wave Zniffer User 
Guide” link to open the User Guide. This requires Adobe Reader (or Acrobat Reader) or any other PDF 
reader software to be installed on your computer. 
If you prefer to manually explore the files, the User Guide is located at 
“<optical_drive_name>\data\SW_DOC\INS10249-5 - Z-Wave Zniffer User Guide.pdf”. 
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3 GETTING STARTED 

3.1 Check the prerequisites 

The following components should be pre-installed on the machine that you need to run Z-Wave Zniffer 
Windows application: 

1. .NET Framework, version 3.5 or later 

2. Windows Installer 3.0  (Windows Installer 3.1 or later is recommended) 

Limitation: Z-Wave Zniffer has been tested on Windows XP with Service Pack 2 (32-bit platform), 
Windows 7 (both 32-bit and 64-bit platforms) and requires the prerequisites listed above. 

Important: Make sure you have the latest service pack and critical updates for the version of Windows 
that you are running. To find the recent security updates, visit Windows Update.  

3.2 Install the Zniffer application 

1. Exit all programs. 

2. In Microsoft Windows, click the Start button, and then click Control Panel. 

3. In Classic view, double-click Add or Remove Programs. 

4. Click Add New Programs, and then click CD or Floppy. 

5. Click Next and then click Browse to locate the “setup.exe” in the 
“<optical_drive_name>\data\DevKit\Tools\Zniffer\PC” folder on Z-Wave Developer’s Kit CD or 
“<drive name>\DevKit_x_xx\Tools\Zniffer\PC” folder on your hard drive in case you installed 
Z-Wave Developer’s Kit already. 

6. Click Finish to start the installation. The welcome page appears as shown at Figure 1.  
Please note the copyright notification and click Next button.  
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Figure 1. Welcome page of Z-Wave Zniffer Installation 

7. Select the installation folder and who should be able to use the Zniffer application.  
Please note, that it is not recommended to move the Zniffer application manually after it has 
been installed into the above specified folder. 
When done, click Next. 
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Figure 2. Installation Folder 

8. License Agreement page appears. Read the license terms for Microsoft SQL Server 2005 
Compact Edition Runtime and select “I Agree” if you accept its terms. Click Next button to 
continue the installation. 
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Figure 3. License Agreement 

Please note, that installation cannot go further without accepting the license agreement. If you 
don’t accept them, select “I Do Not Agree” option and click Cancel button. The installation will 
stop. 

9. Installation confirmation appears. Click Next again to confirm and start the installation.  
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Figure 4. Confirmation page of Z-Wave Zniffer Installation 

10. The actual installation procedure will pass with progress indicator and final confirmation appears. 
Click Close to complete the installation. 



INS10249-7 Z-Wave Zniffer User Guide 2011-09-28 

Sigma Designs Inc. Getting started Page 8 of 41

 CONFIDENTIAL 

 

Figure 5. Installation progress 
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Figure 6. Installation complete 

3.3 Start the Zniffer application 

You can start the Z-Wave Zniffer using the Start menu. To open the Start menu, click the Start button in 
the lower-left corner of your screen. Or, press the Windows logo key on your keyboard. The Start menu 
appears.  

To open Z-Wave Zniffer, click its icon shown in the left pane of the Start menu that displays the most 
frequently used programs list. If you don't see its icon there, click All Programs at the bottom of the left 
pane. Instantly, the left pane displays a long list of programs in alphabetical order, followed by a list of 
folders. Click Zensys folder and finally Z-Wave Zniffer as shown at Figure 7. 
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Figure 7. Start menu 

Each time you start Z-Wave Zniffer, you are actually running the “C:\Program Files\Zensys\Z-Wave 
Zniffer\ZWaveZniffer.exe” executable file, although you do not usually type its name or even see it.  

3.4 Quick-Start Guide 

1. Flash the appropriate hex file to a Z-Wave module. Refer to [1] for instructions on how to do this. 

2. Connect the Z-Wave module / Z-Wave Interface module to a COM port on your PC. 

3. Open Z-Wave Zniffer 

4. Select the COM port from the applications Settings menu, then Port Selection. 
You may also check the Frequency Selection item. 

5. To start capturing the RF traffic, click the Start button at the toolbar or press F5 key on your 
keyboard. 

6. To save your log file, click the Save button at the toolbar or press Ctrl+S keyboard shortcut or 
your keyboard. 
If this is the first time you are saving the file, type a name for the file in the Save As box, and 
then click Save. 
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3.5 Remove Z-Wave Zniffer  

You can uninstall Z-Wave Zniffer from your computer if you no longer use it.  

1. Open Add or Remove Programs in Control Panel. 

To do it, click Start, then click Control Panel (in Classical View – click Start, then point to 
Settings, and click Control Panel), and then double-click Add or Remove Programs. 

2. Click the program in the list and then click the Remove button as shown at Figure 8. You can 
sort programs by selecting different options in Sort by. 

 

Figure 8. Add or Remove Programs window 

3. Standard confirmation dialog appears. Click Yes to continue the removal of the Zniffer software. 

 

Figure 9. Confirmation message for Z-Wave Zniffer removal 
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4. Z-Wave Zniffer and its settings will be completely removed without prompting you further. 

3.6 Troubleshoot installation problems 

Here are solutions to some common problems with installing Z-Wave Zniffer. 

3.6.1 Installation stops without .NET Framework  

 

Figure 10. Problem with .NET Framework 

This is caused by lack of the .NET Framework which is the required component as it is described in 
section 3.1 “Check the prerequisites”. Please install the .NET Framework and run the setup again.  

3.6.2 Installation stops with an error message 

 

Figure 11. Problem with Zniffer installation 

This is caused by previous version of Z-Wave Zniffer that is already installed on your computer and 
cannot be automatically removed. To see the details for this error, click Details button. It displays the 
reason for this error: ”Another version of this product is already installed.  Installation of this version 
cannot continue.  To configure or remove the existing version of this product, use Add/Remove Programs 
on the Control Panel.”  

If you have encountered this problem, uninstall the previous version using standard Windows tools and 
then start the installation of the new version again. For more details see section 3.5 “Remove Z-Wave 
Zniffer”. 
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4 USER INTERFACE 

4.1 Layout of the Zniffer main window 

Figure 12 shows Z-Wave Zniffer as it usually looks after some frames captured or loaded from the 
previously saved file. 

 
Figure 12. Z-Wave Zniffer main application window 

Z-Wave Zniffer main window has the same basic parts as other Windows applications: 

� Title bar displays the name of the program. It may display also the name of opened/saved log 
file. 

� Menu bar contains items that you can click to make choices in a program. See Section 4.2 
“Menu bar”. 

� Toolbar. The row of buttons, which represents tasks you can do within a program. It provides 
quick access to common tasks frequently accessed from the menus. See Section 4.3 “The 
toolbar”. 
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� Frame List pane displays all captured frames with summary information about every frame. By 
clicking on any frame/row in this pane you control what is displayed in the other parts. See 
Section 4.5 “Frame List pane”. 

� Frame Details window displays one frame selected in the packet list pane in more detail. See 
Section 0 “Frame Details window” below. 

� Statusbar shows some detailed information about the current program state and the captured 
data. See Section 4.7 “The status bar”. 

4.2 Menu bar 

On top of the main window is the application menu. It has the following items: 

4.2.1 File menu 

This menu contains items to create new, open, save and merge capture files, and to quit from Z-Wave 
Zniffer. The File menu has the following items: 

Menu item Keyboard Shortcut Description 

New Ctrl+N Clear the current log and initiate a new one and create a file 
for it. 

Open  Opens a standard File Open dialog to open the saved log 
and connect to it in real time. 

Save  Saves the current trace to a file. 

Trace Comment  Add a comment to a trace. 

Reload Command 
Classes XML File 

 Reload the Command Classes XML file, if required. See 
section 7.10 “Editing the Command Classes XML file” 

Exit  Exits the application. 
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4.2.2 Edit menu 

The Edit menu has these items: 

Menu item Keyboard 
Shortcut 

Description 

Copy Ctrl+C Copies the values of the selected frame into the clipboard. 

Select All Ctrl+A Selects all elements in the current window (usually all frames). 

Highlight  Sub-menu with the items to operate the highlighted 
rows/frames 

Highlight 
by Source  

 Highlights all frames/rows with the same Source node ID as 
the selected one 

Highlight by Destination   Highlights all frames/rows that has the same Destination node 
ID as the selected one 

Highlight by Source and 
Destination 

 Highlights all frames/rows sent between the nodes shown as 
Source and Destination node of the selected one 

Clear Highlighting  Removes the active highlighting 

Go to line… Ctrl+G Shows a dialog box where the user can enter a line number. 

The Frame List will then change to this line. 

Find… Ctrl+F Shows a search dialog box to navigate within the visible 
frames in the Frame List 
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4.2.3 View menu 

The View menu has these sub items: 

Menu item Keyboard 
Shortcut 

Description 

Frame Details  Shows/hides the Frame Details window. For more details see 
Section “Frame Details Window” below 

Reset Sort  Resets the sort order for Frame List to the default one (by Line 
No.) 

Autosize  Automatically adjust the width of all columns in the Frame List 
for the best appearance 

Toggle Colors  Switches on and off the foreground and background colors for 
all trace items 

Toggle Filter  Applies/Hides the current display filter while leaving it active 

Drop Filter  Clears all the active display filter conditions 

Add Watch Ctrl+Shift+W Add new Watch window. See Section 7.5 “Watch” 
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4.2.4 Capture menu 

The Capture menu has these sub items: 

Menu item Keyboard 
Shortcut 

Description 

Detect Zniffer Modules  Detect Zniffer modules connected to available serial ports. 

Port Selection  The Port Selection sub-menu allows you to select which serial 
port your Zniffer hardware (Z-Wave Module programmed with 
sniffer embedded application) is connected to. This menu 
contains only the serial ports that are installed on your 
computer and your menu may vary. There is a check mark 
next to the selected serial port. 

 

Frequency Selection  This menu will show you a list of frequencies supported by the 
Zniffer device currently connected to the PC.  

Click on the frequency to select it. 

Detect Serial Ports  Rescan available serial ports. 

Start F5 Starts the capture using the Sniffer connected to the selected 
port at the selected frequency 

Pause Ctrl+Shift+P Pauses capture. Capture can be resumed. 

Stop Ctrl+Shift+S Stops capture. A new capture can be started only. 
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4.3 The toolbar 

The toolbar is located directly below the main menu. It contains the following controls: 

Menu item Icon Description 

New  Creates new log and creates a file 
for it. 

Open Opens the previously saved Zniffer 
log file. See Section 6.1 “Open file”. 

Save Saves the current log into a file.  

Trace 
Comment 

 Add comment to a trace. 
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Start Starts the capture.  

Pause Pauses capture. 
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Stop Stops the capture. 

Reload 
Command 
Classes XML 
file 

 Reload the Command Classes XML 
file, if required. See section 7.10 
“Editing the Command Classes XML 
file” 

Add Watch  Add new Watch window. See 
Section 7.5 “Watch” 

Go to line 
number 

 Navigates to the frame with the 
given Line No. 

Find Specific 
line 

 Opens a dialog to find a frame with 
specific characteristics. 

Copy Copy a selected trace item(s) to the 
clipboard 

Reset Sort  Resets the sort order for Frame List 
to the default one (by Line No.) 
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Auto size 
Columns 

 Automatically adjust the width of all 
columns in the Frame List for the 
best appearance. 

Toggle Colors  Switches on and off the foreground 
and background colors for all trace 
items. 

Drop Filter  Clear all the display filter conditions. 

Toggle Filter Apply/Hide the current display filter 
while leaving it active. 

Zoom  Change the font size in the frame list 
pane. 

Auto Scroll  Click to start and stop automatically 
scrolling to last trace items in the 
Frame List. 

Port  The dropdown list selector of the 
serial port for the application to run 
on. 

Detect Zniffer 
Modules 

 Detect Zniffer modules connected to 
available serial ports. 

Frequency  Select working frequency. 

 

4.4 Keyboard shortcuts  

The following table contains the keyboard shortcuts. 
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Press this key To do this 

CTRL+C Copy the selected item to Windows Clipboard. 

CTRL+A Select all items in a window (usually all frames in Frame List pane). 

CTRL+N Clears the current log and initiate a new one. 

CTRL+O Opens a standard File Open dialog to open the saved log. 

CTRL+S Saves the current trace to a file. 

ALT+F4 Exits the application. 

ESC Cancel the current task (close active dialog). 

F5 Starts the capture using the Sniffer connected to the selected port at the 
selected frequency 

CTRL+SHIFT+P Pauses capture. Capture can be resumed 

CTRL+SHIFT+S Stops capture. A new capture can be started only 

CTRL+G Shows a dialog box where the user can enter a line number. 

The Frame List will then change to this line. 

CTRL+F Shows a search dialog box to navigate within the visible frames in the Frame 
List 

CTRL+SHIFT+W Add new Watch window. 
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4.5 Frame List pane 

The frame list pane is a table that enlists all the captured or opened frames. This table has the following 
columns: 

Column Name Description 

Line No. The line number for the frame. 

Date The date when the frame has been captured. 

Time The time when the frame has been captured. 

Speed Transmission rate: 9600 bits per second or 40 kilobit per second 

RSSI RSSI value as measured by the node 

Channel Channel in use by the node 

Delta Time since that last frame was captured, in milliseconds. 

Source Node ID of the source device. If frame is being routed the following format is used: 
xx(yy) where, xx is the node forwarding the frame from original node yy 

Destination Node ID of the destination device(s). If frame is being routed the following format is 
used: xx(yy) where, xx is the node forwarding the frame to ultimately reach yy. 

Home ID The unique ID of the Z-Wave network where the frame originated. 

Data Frame type, that is whether it is a Singlecast, Multicast, Broadcast or acknowledge 
frame and whether it is routed or not. In case of routed frames the following format is 
added: xx(yy)->zz, where xx is the node forwarding the frame, yy the original sender 
and zz the destination. 

Application Information about the application part of the frame. 

Attention! The values for this column are taken from the frame using the data from 
XML file  

Hex Data Hex Dump of the entire frame. 

 

To sort the Line No. column values descending, click its header. Please note a triangle sign on the right 
that shows the current sort order. To sort the Line No. column values ascending, click the column header 
again.  

To automatically fit the width of all columns for the best appearance with the current display font settings 
and window size, click Autosize Columns button at the toolbar.  

4.6 Frame Details window 

In the window below the Frame List pane, you can see the Frame Details with all the details about the 
one currently selected frame. 
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Figure 13. Frame Details window 

Zniffer parses the frames captured from RF using XML files (format R1) generated by the Z-Wave XML 
Editor [3]. In addition, the Z-Wave XML Editor allows the customer to define command classes under 
development or proprietary command class structures and thereby enabling interpretation in the Zniffer 
tool. 

To show/hide the Frame Details window click View menu, then click Frame Details or the arrow button 
in the window top. 

4.7 The status bar 

 

Figure 14. Status bar 
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In the status bar on the bottom, you can see status information: 

Area Description 

Frames: N (X frames/sec; Y B/sec) Total count of the frames that have been captured in the log and the 
average data speed. 

Line: N Line number of the current frame 

Selected Count: X Timespan: Y Quantity of selected frames and the total time span of these selected 
frames calculated on basis of Delta values 

Is Filtered: False/True Status of the current display filter. It displays “Filtered: True” if some 
display is active or “Filtered: False” if display filter is inactive or 
display conditions are empty. 

Note! After starting capturing the traffic, you may see an empty 
Frame List pane while traffic is coming. Check the Filtered state at 
the status bar to make sure you have no display filter that prevents 
frames from being displayed in the Frame List. 

Port: X Active Port selection 

Frequency: X Active Frequency selection. 
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5 CAPTURING LIVE RF TRAFFIC 

5.1 Introduction 

Capturing live Z-Wave network RF messages is one of the major features of Z-Wave Zniffer.  

Zniffer capture engine provides the following features:  

� Capture messages from all Z-Wave devices within direct RF range.  

� Stop the capture on different triggers like: capture duration, captured number of frames, size of 
log file.  

� Simultaneously show decoded frames while keep on capturing.  

5.2 Prerequisites  

Setting the environment you need to capture the Z-Wave network RF communication for the first time 
could be tricky. 

You need the following items: 

� Z-Wave module. ZW040x based Z-Wave module is recommended. This module supports 
9.6 kbps, 40 kbps and 100 kbps RF communication. 

� Firmware in a correct HEX file to be flashed for running the Sniffer on Z-Wave module. 
Sniffer_ZW040x.hex is needed for the recommended Z-Wave module. 

� Available COM port with properly connected Z-Wave module 

5.3 Capturing interface 

To check or select the COM port where Z-Wave Zniffer application will look for Z-Wave module with 
Sniffer firmware connected, under Capture menu, select Detect Zniffer Modules (or click the 
corresponding button on the toolbar) 

 

Figure 15. Detect Ports dialog 

After this, select the proper COM port from the dropdown list. If any port is connected to Z-Wave device, 
then it displays also some system information for that device – chip type and revision and firmware 
version and revision. 
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To check or select the frequency of RF communication that Zniffer will capture, click Capture, then click 
Frequency Selection item (or select from the dropdown list on the toolbar). Select an appropriate 
frequency region in sub-menu that appears. 

5.4 Start capturing 

To start capturing the RF communication of Z-Wave network, click the Start button at the toolbar. Or 
press F5 key on your keyboard. Or click Capture file, and then click Start item. 

If Start action is initiated in the newly opened environment or after the Pause action then: 

� the capture will continue (resume) without clearing the capture 

� the Delta for the first frame is zero 

If Start action is launched after the Stop action then it checks either the capture has been saved: 

� If the capture has been saved then it starts the new capture. 

� If the capture has NOT been saved then it opens the confirmation dialog with standard question 
about saving the unsaved data and Yes and No buttons. If Yes clicked then clear the Frame List 
and immediately start the new capture. If No is clicked then nothing happens. 

5.5 Pause capturing 

Pause action interrupts the capturing RF communication of Z-Wave network. To pause capturing, click 
Pause button at the toolbar, or press Ctrl+Shift+P shortcut on your keyboard, or click Capture menu 
and then click Pause item. 

The second click on Pause button works in the same way as the Start button: 

� the capture will continue (resume) without clearing the captured Frame List 

� the Delta for the first frame is zero 

5.6 Stop capturing  

Stop action stops the capturing RF communication of Z-Wave network without the possibility to continue 
the capture. To stop capturing, click Stop button at the toolbar, or press Ctrl+Shift+S shortcut on your 
keyboard, or click Capture menu and then click Stop item. 

5.7 Restart a running capture 

To restart capturing do Stop and Start actions as described above. If you captured any frame it will open 
a confirmation dialog.  
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Figure 16. Clear the capture confirmation dialog 

Click Yes to continue with clearing out the captured Frame List. Or click No to cancel the capture restart 
and remain with the captured Frame List. 

5.8 Saving the trace to a file 

To start saving the trace into a file, use the Create New Trace option. Use File > New from the main 
menu, or Create New Trace from the toolbar. You will be asked to Save As your trace before starting 
capture. 

5.9 Troubleshoot capturing frames 

Here are solutions to some common problems with capturing the frames in Z-Wave Zniffer. 

5.9.1 Capture starts but Frame List is empty 

This could be caused by these typical reasons: 

� Capture interface has not been selected or wrong port and/or frequency has been selected. 
Check the current interface selection using the information that Status bar displays on the right. 

 

Make sure you have selected the correct COM port and frequency before stating the capture. 
Use the Capture menu to change the interface selection. 

� Display Filter is applied. The frames are coming but Frame List is empty because all the frames 
are filtered out. Check this current status of Display Filter using an icon in Status bar. 

 

To fix this temporarily de-activate the filter using Toggle Filter button at the toolbar or drop the 
filter if you don’t need it anymore using Drop Filter button at the toolbar. 

5.9.2 Frame List does not scroll automatically 

In some cases Frame List could not scroll automatically while Auto Scroll option is selected. This could 
be caused by non-default sort order you have applied. Sort order is very easy to change by simple click 
on any column heading. Please note, that Auto Scroll option automatically scrolls the Frame List to the 
last frame, which is the frame with the greatest LineNo value. Some sort order could make the new 
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frames to appear in the beginning of the Frame List, which could look confusing. 
To apply the default sort order, click Reset Sort button at the toolbar.  
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6 FILE INPUT/OUTPUT 

6.1 Open file 

1. To open any previously saved log file, click File menu, then click Open. Or press Ctrl+O 
keyboard shortcut. Or click Open button at the toolbar. Standard Open dialog appears as shown 
at Figure 17.  

 

Figure 17. Open file dialog 
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2. In the Look in list, click the folder, drive, or Internet location that contains the file that you want to 
open. 

3. To check or select the file type, use Files of type drop-down list. Current Z-Wave Zniffer 
supports two file types: .ZBF files that are binary data files and .ZNF files that are plain text files 
saved using the Zniffer version 1.0. The native ZBF file format is selected by default. 

4. In the folder list, locate and open the folder that contains the file. 

5. Click the file, and then click Open. 

 

Another option is to open a log file directly from the Windows environment. 

1. Find the file that you want to open. 

2. Double-click the file to start Z-Wave Zniffer and open the selected file. 
If you have a file that will not open, you probably need to install Z-Wave Zniffer. 

6.2 Save a file  

It is recommended to save the captured frames in a file to avoid losing data unexpectedly due to a power 
failure or other problem.  

To save your capture file, stop the trace, click the Save button at the toolbar; or press Ctrl+S keyboard 
shortcut on your keyboard; or click File menu and then click Save. 

Type a name for the file in the Save As box. 

To specify the range of saved frames, select one of the available options using the File > Save As 
option: 

� Selected Items, to save the selected frames only; 

� Filtered Items, to save the filtered frames only; 

When finished, click Save. 

6.3 Add a comment to the trace 

It is possible to add a text comment to the trace. Select File > Trace Comment from the main menu or 
Trace Comment on the Toolbar to add your comment. 

6.4 Open files saved in older Zniffer formats 

The current version of Zniffer creates log files in .ZLF format. However, it can also read .ZBF and .ZNF 
file formats created with previous version of the Zniffer application. To do this, the File Converter 
application must be installed in addition to the Zniffer application. 
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7 WORKING WITH CAPTURED PACKETS 

7.1 Navigation within frames 

To simplify the navigation within frames in Frame List use Go To Line and Find dialogs. 

7.1.1 Navigation with Go To Line dialog 

To quickly navigate to a frame with any given Line No, use Go To action. Click Edit menu, then click 
GoTo Line item. Or press Ctrl+G shortcut at your keyboard. Or right-click at any row in Frame List and 
select Go To item in shortcut menu. 

 

Figure 18. Go To Line dialog 

To quickly navigate without opening a separate Go To Line dialog, use Go to Line textbox and button at 
the toolbar. Enter the Line No value and press ENTER on your keyboard or click the Got To button. 

7.1.2 Navigation with Find frame dialog 

To open Find dialog, click Edit menu, then click Find item. Or press Ctrl+F shortcut on your keyboard. 

 

Figure 19. Find frame dialog 

Find dialog includes control to set the find criteria by several columns:  

� Date; 
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� Source Node ID 
 

� Destination Node ID 
 

� Home ID 
 

� Time 
 

� Data - contains the list of available human-readable values in favor of hexadecimal codes; 
 

� Application - contains the list of available human-readable values in favor of hexadecimal codes. 
 

Select the required comparison operator and enter or select the required value for every field you want to 
look for. 

Select the search direction, that is top-down by default. 

To navigate to the next occurrence of the frame that meets the entered criteria, click Find Next or press 
ENTER button on your keyboard. Find dialog changes the active row in Frame List and remains on the 
top of other Z-Wave Zniffer until been intentionally closed. 

To exit from Find dialog, click Cancel button at the bottom of the dialog or click Close button at the title 
bar. 

7.2 Highlighting frames 

To highlight the frames you need, right-click at the frame you would like to use as a sample and select 
Highlight Frames item in shortcut menu. It has the following sub-menu items: 

� By Source Node ID highlights all frames that has the same Source node ID as the selected one; 

� By Destination Node ID highlights all frames that has the same Destination node ID as the 
selected one; 

� Highlight by Source and Destination highlights all frames sent between the nodes shown as 
Source and Destination node of the selected one; 

� Clear Highlighting removes any active highlighting. 

Right-clicking on the column header and selecting any of the highlighting options will result in 
corresponding highlighting of all frames. 

7.3 Using display filter 

To reduce the amount of the frames that are displayed at Frame List use filters.  
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Attention! Please note that display filter affects the displayed frames while the total captured frames 
remains untouched. 

Filtering can be applied by Date, Source, Destination, Home ID, Data, Application. 

To apply the display filter that uses some value for the filtering criterion, use Filter icon at the column 
heading in the Frame List. Click the icon to open the drop-down list with the available values.  

 

Figure 20. Quick filter drop-down list for Destination column 

Enter the required value to apply the filtering by this value only. 

Clear the input field and press OK to drop the active filter. 

7.4 Control active filters 

To clear the filtering conditions, click Drop Filter button at the toolbar. 

To activate/deactivate the current filter while pre-serving it, click Toggle Filter button at the toolbar. 

7.5 Working with encrypted frames 

Some of the frames that Zniffer captured could be secure (encrypted) frames. The frames that Zniffer 
was unable to decrypt using known encryption keys contain a special Decrypt link in the Frame Details 
window as shown at the figure below. 
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Figure 21. Decrypt button in the Frame Details window 

 

To enter the required key click the Decrypt link or press Ctrl+Shift+D shortcut at your keyboard. 
Encryption Key dialog appears as shown at the figure below.  

 

Figure 22. Encryption Key dialog 

Attention! Zniffer is unable to automatically define what particular key should be entered – either 
network key for a whole Secure Z-Wave Network or temporary (inclusion) key for some node. So user 
has to follow the sequence of the events/frames and define what key should be entered. 
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The key values according to the Secure Command Class Specifications should be 16 hexadecimal 
values long. Encryption Key dialogs supports two possible formats – space-separated values (e.g. “01 02 
03 04…”) and continuous string (e.g. “01020304…”).  

Zniffer adds trailing zeros 0x00 up to 16 hexadecimal values. So if you have to enter “01 02 03 04 00 00 
00 00 00 00 00 00 00 00 00 00” you can enter just “01 02 03 04” or “01020304”. 

Attention! Note please that Encryption Key dialog accepts even number of values only. 

Click Ok to apply the entered key and store it into the Key Storage that Zniffer will try to use for any 
secured frame within current capture. 

If the frame could be decrypted using the key user provided then Zniffer displays the decrypted 
information in the Frame Details window. If the key is incorrect then the Notification tooltip appears in the 
Frame Details window as shown at the figure below. 

 

Figure 23. Notification tooltip about incorrect key 

Attention! Note please that all the keys user provided are saved in the .ZBF file and restored 
automatically during file opening. 

7.6 6lowPAN Datagrams 

Zniffer can parse 6lowPAN datagrams. When the trace contains traffic with 6lowPAN datagrams, select 
Tools > 6lowPAN Datagrams, and press the Parse button in the 6lowPAN Datagram pane. 

The Frame Details pane will show parsed information obtained from the selected 6lowPAN datagram. 



INS10249-7 Z-Wave Zniffer User Guide 2011-09-28 

Sigma Designs Inc. Working with captured packets Page 37 of 41

 CONFIDENTIAL 

 

Figure 24. 6lowPAN Datagrams pane 

7.7 Transport Service Datagrams 

Zniffer can parse transport service datagrams. When the trace contains traffic with transport service 
datagrams, select Tools > Transport Service Datagrams, and press the Parse button in the Transport 
Service Datagram pane. 

The Frame Details pane will show parsed information obtained from the selected transport service 
datagram. 

 

7.8 Watch 

Watch allows tracking the rare frames and fast navigating to occurrence in the trace.  

To open Set up watch filter dialog, click View menu, then click Watch. Or press Ctrl+Shift+W keyboard 
shortcut.   
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Figure 25. Watch Criteria dialog 

Enter the appropriate criteria using any combination of the available entry fields: 

� Date; 

� Source Node ID, to use the values of source node ID as a criterion. Specify either single value 
(with the “Equal” operator) or click ellipsis button to specify the list of the values in a separate 
popup dialog (with the “List” operator). 

� Destination Node ID, to use the values of destination node ID as a criterion. Could be used with 
several operators: Starts with, Ends with, Contains, Equals, and List. 
Attention! Due to special handling of the destination node ID especially in Multicast frame type, 
its values should be entered with leading zeros, e.g. “003” instead of “3” and “034” instead of 
“34”.  

� Home ID, to use Z-Wave Network ID as a criterion. Could be used with several operators: Starts 
with, Ends with, Contains, Equals, and List. 

� Data, to use that parsed human-readable description of the frame  

� Application, to use that parsed human-readable description of the frame.  
 

To apply the criteria to the Watch window, click Ok. 

The figure below displays a sample Watch window.  
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Figure 26. Watch window displays frames 

7.9 Best practices in handling the frames 

7.9.1 Select the specific frames 

Sometimes it is difficult to manually select the specific frames while selection is required to target the 
range of the frames to perform the further action upon.  

Here are the recommended solutions: 

� Highlight the frames by specific Source node ID, Destination node ID or between specific 
nodes, and then click Select Highlighted. See section 7.2 for more details. 

� Apply display filter to reduce the amount of visible frames by specific criteria and then click 
Select All. See section 7.3 for more details. 

7.9.2 Operate the large capture 

After running the Zniffer in very active Z-Wave network, it can capture very big amount of frames that is 
rather difficult to operate with. Another reason for reducing the amount of frames is the need to send the 
capture file with specific frames for analysis to somewhere else. 

Here are the recommended solutions: 

� Select the specific frames and then click Save As to save as new file. Select Selected only 
option in Save Items drop-down list and finally click Save. For more details, see section 6.2. 

� Apply filter using Filter dialog or quick filter and then click Save As to save as new file. Select 
Displayed option in Save Items drop-down list and finally click Save. For more details, see 
section 7.3. 

� Before starting the capture, specify the criteria for automatic saving the multiple files when some 
condition is reached using Capture Options dialog. For more details, see section Error! 
Reference source not found.. 

 

7.10 Editing the Command Classes XML file 

If the Zniffer does not parse user-defined command classes, it is required to edit the Command Classes 
XML file manually. 
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In Windows 7, the Command Classes XML file is located at 
C:\Users\{username}\AppData\Roaming\Sigma Designs\Z-Wave Zniffer 

In Windows XP, the Command Classes XML file is located at C:\Documents and 
Settings\{username}\Application Data\Sigma Designs\Z-Wave Zniffer 

When the Command Classes XML file has been edited manually, it must be reloaded in the Zniffer 
application. Select File > Reload Command Classes XML file from the Main Menu or press the button 
on the Toolbar. 
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